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Warning:

If you are prone to photosensitivity or photosensitive 
seizures, you should not use this product. If you feel 
dizzy, disoriented, nauseous or suffer from convulsions, 
immediately stop using this product and seek  medical 
attention.

This product uses a keyboard for input. Excessive and 
repetitive use of a keyboard may result in a repetitive stress 
injury. It is important to take regular breaks while playing 
to help prevent such injuries. If you feel pain or swelling 
in your hands or arms, immediately stop using this product 
and seek medical attention.

Important Notice:

This version of Qublix is intended for submission to the 
2007 Independent Games Festival (Student Showcase 
Competition). It is not to be distributed or transferred 
outside of the PouncingKitten Games website without 
permission.
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What is Qublix? Installation

Qublix is an evolution of the classic two dimensional 
sliding tile puzzle (sometimes called the 15-tile puzzle). 
Instead of having a single, two dimensional puzzle, players 
are required to complete a sliding tile puzzle on six sides 
of a three dimensional cube. The edges of each puzzle are 
shared with the puzzles on each adjacent side. As pieces are 
moved and aligned on one side, pieces on the adjacent sides 
will also be moved.
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Old Style New Style

The process detailed below is intended for a default 
Windows XP confi guration and may be different for your 
system.

From a CDROM: The autorun feature may be used to 
install Qublix by inserting the CDROM into a CDROM 
compatible drive and following the installation prompts. If 
the autorun feature does not function or has been disabled, 
the installation program may be started as follows:

1. Double-click on “My Computer” from the Windows 
desktop.
2. Open the CD drive which contains the Qublix 
installation CDROM.
3. Double-click the “Setup.exe” program.
4. Follow the installation prompts to complete the 
installation process.

From a downloaded fi le:

1. Double-click on “My Computer” from the Windows 
desktop.
2. Navigate through the Windows Explorer window to the 
downloaded fi le’s location.
3. Double-click the “QublixInstall.exe” program.
4. Follow the installation prompts to complete the 
installation process.
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Qublix can be removed through the “Add or Remove 
Programs” feature of the Windows Control Panel:

1. Click “Start” from the Windows taskbar.
2. Select “Settings” followed by “Control Panel”.
3. Doubleclick “Add or Remove Programs”.
4. From the “Change or Remove Programs” tab, fi nd and 
click the “Qublix for Windows”.
5. Click the “Remove” button.
6. Click “Yes” when prompted to fi nish removing Qublix.

Note: Some fi les (confi guration settings, high scores, user 
created puzzle fi les) may remain after uninstallation and 
will need to be removed manually.

Uninstallation Default Controls

See “Controller Settings Menu” for information on control 
customization. 

Menu controls
Change menu selection up:  Up Arrow*
Change menu selection down: Down Arrow*
Change menu selection left:  Left Arrow*
Change menu selection right:  Right Arrow*
Confi rm:    Enter
Cancel:    Escape

Puzzle controls
Move block up:   Up Arrow*
Move block down:   Down Arrow*
Move block left:   Left Arrow*
Move block right:   Right Arrow*
Rotate puzzle up:   ‘W’ or Mouse Up
Rotate puzzle down:   ‘S’ or Mouse Down
Rotate puzzle left:   ‘A’ or Mouse Left
Rotate puzzle right:   ‘D’ or Mouse Right
Pause:     Tab
Zoom in:    ‘+’ (Plus)
Zoom out:    ‘-’ (Minus)

* The four directional keys are shared between the menu 
and puzzle controls. Changes to these keys will affect both 
the “change menu selection” and “move block” commands.
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Main Menu

(1) Select Puzzle: Puzzles and diffi culty levels are chosen 
from this screen (see “Select Puzzle Menu”).
(2) Options: Allows changes to the controls, game options 
and whether or not sound is played (see “Options Menu”).
(3) Credits: Displays information about Qublix.
(4) Exit: Exits the Qublix program.

(1) Puzzle name: The name of the selected puzzle is shown 
here. This may not be the same as the fi le name of the 
puzzle.
(2) Diffi culty: The currently selected diffi culty level is 
shown here. It can be changed by moving left or right. 
Four diffi culty levels are available to choose from: Easy, 
Medium, Hard and Impossible.
(3) Puzzle size: The number of blocks per side for the 
selected puzzle. For example, a 3x3x3 puzzle is three 
blocks wide, by three blocks high, by three blocks deep.
(4) Best completion time: If the puzzle has been completed, 
the time is shown here in Hours:Minutes:Seconds.
(5) Additional selections indicator: These arrows appear 
when the puzzle list can be scrolled to select more puzzles.

Select Puzzle Menu
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Options Menu

(1) Game Settings: Gameplay related settings are changed 
here (see “Game Settings Menu”).
(2) Controller Settings: Allows the command keys and 
mouse behavior to be changed (see “Controller Settings 
Menu”).
(3) Sound Settings: Sound effects can be enabled or 
disabled from this menu (see “Sound Settings Menu”).

(1) Puzzle rotation: “Free” rotation allows the puzzle to be 
rotated by any degree and allows several puzzle sides to 
be seen at the same time. “Step” rotation locks the puzzle 
rotation to 90 degree increments and only allows one side 
at a time to be seen.
(2) Show space: Shows or hides the block that is normally 
removed so that blocks are able to slide.
(3) Move space/blocks: “Space” moves the space (i.e. 
“up” moves the space up). “Blocks” moves the blocks 
surrounding the space (i.e. “up” moves the block above the 
space down).
(4) Show hint: Shows or hides the completed puzzle “hint” 
when the game is paused.
(5) Save Settings: Saves the setting changes and returns to 
the previous menu.

Game Settings Menu
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Controller Settings Menu

(1) Control setting: Changes the keyboard key for the 
selected command. To change the command key, select 
the command to change, press the confi rm button and then 
press the new key to use for that command. If a duplicate 
key is pressed, the old command for that key will need a 
new key assigned to it before the settings may be saved.
(2) Mouse axis setting: Flips the X or Y axis and changes 
the direction of puzzle rotation when using the mouse.
(3) Save Settings: Saves the setting changes and returns to 
the previous menu.
(4) Additional selections indicator: These arrows appear 
when the settings list can be scrolled to select more 

(1) Play sounds: Plays or mutes all of the sounds effects for 
the game.
(2) Save Settings: Saves the setting changes and returns to 
the previous menu.

Sound Settings Menu
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Play Screen

(1) Active Qublix puzzle.
(2) Removed space. If “show space” is set to true, then this 
block will fl ash.
(3) Number of moves taken so far.
(4) Current play time shown in Hours:Minutes:Seconds.
(5) Completed sides indicator. Red boxes are incomplete 
sides, green boxes are completed sides.
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(1) Completed puzzle. Shown if “show hint” is set to true.
(2) Current puzzle name.
(3) Current puzzle description.
(4) Number of moves taken so far.
(5) Current play time shown in Hours:Minutes:Seconds.
(6) Best completion time. If the puzzle has been completed, 
time is shown in Hours:Minutes:Seconds.
(7) Current diffi culty level.
(8) Opens the Options menu.
(9) Opens the Save/Exit menu.
(10) Unpauses the game and returns to the play screen.

Pause Screen
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How to Play

Qublix plays just like a typical sliding tile puzzle. Once a 
puzzle is selected and loaded, a block is chosen at random 
to be removed (it is called the “space”) and the remaining 
blocks are moved at random. The higher the diffi culty level, 
the higher the number of random moves.

Each Qublix puzzle contains a picture on each of its six 
sides. Portions of these pictures are attached to each block. 
As the blocks are moved around, the picture for that side is 
mixed up:

Finishing a Qublix puzzle is simple, just complete the 
picture on each of the six sides. Having all of the pictures 
completed at the same time is the hard part.

Before mixing
(Complete)

After mixing
(Incomplete)

The problem is that each time a block is moved, it changes 
the picture arrangement on each side the block is currently 
a part of. Here is an example:
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The number 2 block moves down.

The number 3 block moves left.

When the number 2 block is moved as shown above, 
it changes both the front and top sides of the puzzle. 
However, when the number 3 block is moved, it changes 
three sides (front, top and right) of the puzzle.
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Saving & Loading Progress

Qublix puzzles can have anywhere between 8 (2x2x2) 
and 1362 (16x16x16) individual blocks to move around. 
For larger puzzles, it would be impossible to complete in 
a single sitting. Fortunately, progress can be saved and 
puzzles can be completed at leisure.

How to Save:

From the pause menu, select the “Save/Exit” option. The 
screen below will be shown:
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(1) Save and Exit: Saves the progress for the current 
puzzle and returns to the puzzle selection menu. This will 
overwrite any saved progress for the current puzzle.
(2) Exit Without Saving: Returns to the puzzle selection 
menu, but any progress is lost.
(3) Cancel: Returns to the pause screen without saving and 
without losing any progress.

Each puzzle can have several progress saves. However, 
there can only be one save for each diffi culty level for a 
puzzle. Also, once a puzzle has been completed, any saved 
progress for that diffi culty level is automatically removed.

How to Load:

The game checks for a progress save every time a puzzle is 
started. If a progress save exists for the chosen puzzle and 
diffi culty level, a load progress menu is displayed.

If “yes” is selected from the load menu, the previously 
saved progress (including the number of moves and play 
time) is loaded. If “no” is selected, the puzzle is instead 
loaded and randomized as normal. The progress save is not 
removed if “no” is selected, but it may be overwritten by a 
new save.
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Qublix Editor

The Qublix Editor allows anyone to create and modify 
Qublix puzzles. These puzzles can then be shared and 
played by anyone with Qublix installed. The editor looks 
like this:

1

2 3

(1) Main editor window: This window displays the 
unfolded Qublix puzzle. Each of the six side pictures can 
be loaded from here.
(2) Puzzle information window: Selecting “Set 
Information” from the “Settings” menu or pressing Ctrl+I 
opens this dialog box. The name, description and side 
image resolution can be set here.
(3) Puzzle dimensions window: Selecting “Set 
Dimensions” from the “Settings” menu or pressing Ctrl+D 
opens this dialog box. The number of blocks for each 
puzzle dimension (width, height and depth) can be set here.

Creating a New Puzzle:

1. When the editor is fi rst started, a default blank puzzle is 
ready to be fi lled in. If a puzzle is already loaded, “New” 
can be selected from the “File” menu or Ctrl+N can be 
pressed to create a blank puzzle.
2. Each of the six puzzle sides must have a picture assigned 
to it. Clicking on each of the six buttons allows a picture to 
be selected and loaded. Once loaded, the image is displayed 
on the button. The same image may be used for different 
sides, but it must be loaded individually for each side. Valid 
image formats include: BMP, GIF, JPG and PNG.
3. The puzzle name and description should be set. The 
name can be up to 16 characters long with no restrictions. 
The description can be up to 64 characters long. Both
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should properly describe the puzzle being created and will 
be displayed in Qublix when the puzzle is played.
4. The puzzle dimensions default to 2x2x2. If the puzzle 
needs to have different dimensions, they can be set from the  
“Set Puzzle Dimensions” dialog box.
5. The puzzle can now be saved by selecting “Save” from 
the “File” menu or pressing Ctrl+S. The fi lename for the 
puzzle should be unique to prevent other puzzles from 
being copied over.

Editing Existing Puzzles:

Existing puzzles can be loaded by choosing “Open” from 
the “File” menu or pressing Ctrl+O. If Qublix has been 
properly installed, puzzles ending with the QBX extension 
can be opened by doubleclicking them from Windows 
Explorer.

Playing New Puzzles:

To play a new puzzle, simply copy it into the Puzzles 
directory and reload the Qublix game.

Editor Notes:

The editor creates a new internal puzzle ID each time a 
puzzle is saved. This ID is used by Qublix for saving puzzle 
completion times. If an existing puzzle is saved, even if the 
puzzle itself is unchanged, a new ID will be created and 
any previous completion times will be lost.

Loaded images will be resized to the resolutions specifi ed 
in the “Set Puzzle Information” dialog box. For best results, 
images should be resized to the desired dimensions by an 
external graphics program. The minimum image resolution 
is 128 pixels. The maximum image resolution is 1024 
pixels.
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Qublix Skin

The interface for Qublix is completely editable. The 
graphical elements for the game skin are stored in a single 
PNG image fi le named “skin.png”. The image fi le is 1024 
pixels wide by 512 pixels high. If this fi le is changed or 
replaced, the image resolution should remain the same.

The skin fi le contains the following defi ned elements and 
pixel positions:

Element Start X Start Y Width Height
PlayMoves 0 0 256 256
PlayComp 256 0 256 256
PlayBlank 512 0 256 256
PauseBest 768 0 256 256

PauseMenu 768 256 256 256
SmSelection 384 352 224 64
MdSelection 0 352 384 96
LgSelection 0 256 768 96
UpIndicator 0 448 64 64
DnIndicator 64 448 64 64
SideComp 128 448 64 64

SideIncomp 196 448 64 64

Skin Notes:

Creating a new skin or modifying the default skin is only 
recommended for advanced users with knowledge of 
graphical editing tools.

A backup of the skin fi le should be made before attempting 
to edit or replace. If the skin fi le cannot be loaded or if the 
graphical elements are not aligned properly, the Qublix 
interface may be unreadable.

Each graphical element should be designed so that there is 
at least one pixel between the element and its boundaries 
as given in the element table. This is necessary to prevent 
element overlapping when the images are stretched for 
various resolutions.
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Product Support

We welcome all feedback, both good and bad. If you have 
any comments, please visit our forums or send us an email 
using the contact information below.

This product is provided without express or implied 
warranty. For questions or product support, please use the 
contact information below.

Contact Information:

Join the PouncingKitten Games forums to discuss Qublix 
or to seek help for any problems:

http://www.pouncingkitten.com

Email Qublix support at:

qublix@pouncingkitten.com

Credits

Qublix is a presentation of PouncingKitten Games.

Some puzzle images courtesy of NASA/JPL-Caltech. 
The use of these images is compliant with the NASA/
JPL “Image Usage Guidelines” and does not imply an 
endorsement or acknowledgement by either NASA or JPL-
Caltech.

“Qublix”, “Qublix for Windows”, “PouncingKitten 
Games”, the “Kitana” silhouette, other associated logos and 
original puzzle designs are copyrighted by PouncingKitten 
Games © 2006. All Rights Reserved. Version 1.2
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